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Using this 
template  

The standard headings and tables in this template should be modified to meet the 
requirements of each Initial Assessment.  The sites may have diverse issues and 
constraints and problems and the standard template is therefore just a guide on 
typical requirements but flexibility is allowed to amend/ add headings as required 

 
 Hidden 
guidance  

The template contains various pieces of guidance covering content, use of tables 
etc.  The guidance is shown in blue text and can be turned ‘on’ to assist in the 
writing stages or ‘hidden’ for viewing or when printing the document.  You can 
switch between ‘hidden’ and ‘on’ and back to ‘hidden’ at any time. 

To show/hide the guidance click on the ¶ icon on the MS Word toolbar.  

If the hidden text does not disappear off the screen when the ¶ icon is clicked, go 
to:  Tools>Options>View Tab and uncheck the ‘Hidden text’ box.   

It is advisable to work with the hidden text turned on, as this helps to format new 
text and to avoid deleting the hidden text itself. 

 
Auto-
updating of 
contents 
page 

The contents page will update to reflect changed information in the main text and 
tables.  To update right click on the relevant area of the contents page, to highlight 
it, and select ‘Update Field” to access the update option. 

To enable these updating features to be created, the document contains specific 
text types and “fields”.  These are Headings 1, 2, 3 & 4; fields in the table labels 
and in the appendix labels.  When editing the document, take care to maintain 
these aspects. 

 
Inserting new 
headings  

To insert new headings in the main text go to: Format>Styles and Formatting to 
open the styles box. Insert the new headings, highlight it and click on the 
appropriate Heading level in the ‘Pick formatting to apply’ box.  Paragraph text 
can be inserted and formatted in a similar way. 

 
Inserting new 
tables  

Table labels should be added by Insert>Reference>Caption and selecting ‘Table’ 
from the drop down ‘Label’ box.  This will insert the Table title with the correct 
number and the caption can be typed in after the label.  Tables can then be cross 
referenced from the text by Insert>Reference>Cross Reference and selecting the 
appropriate reference type and caption from the drop down box and list. 

 
Numbering 
paragraphs  

All paragraphs should be numbered sequentially as sub-sets of the section 
number. Prompts for paragraph numbering are provided as ‘Start writing here’ 
after which pressing <return> will automatically provide the next paragraph 
number.  
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Ilkley Denton Road FAS 
February 2017 
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1.1  Introduction and background 

1.1.1 Background 

This is an initial assessment looking at possible new flood defences at Ilkley, West Yorkshire. At 
present, there are no registered flood defences at Ilkley and no areas benefiting from defences. 
An initial design for a flood alleviation scheme was proposed in 1992, however, this was not 
taken forward to construction. This scheme has funding allocated in year 7 (2022 – 2024).  

1.1.2 Description of Location 
 
The study area extends from the west of Ilkley town at the upstream end to the Ilkley sewage 
works at the downstream end (shown in Figure 1).  
 
The River Wharfe at Ilkley is a predominantly natural channel, with several semi natural weirs. 

Ilkley falls within the Ouse Catchment Flood Management Plan and the Bradford District Local 
Flood Risk Management Strategy. 

Ilkley is in the low-range of deprivation, with areas ranging from the 1st to the 4th decile of 
deprivation (Figure 2). The majority of the area in question is within the 3rd decile, therefore, there 
are minimal opportunities for socio-economic improvements in the area. 

 
Figure 1 : Location map. The study area is shown in red. 

 
Figure 2: Levels of social deprivation in Ilkley, West Yorkshire 

(http://dclgapps.communities.gov.uk/imd/idmap.html) 
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1.1.3 Description of Watercourses and Geology 

The main watercourse running through Ilkley is the River Wharfe. The River Wharfe is a tributary 
of the River Ouse (which itself is a tributary of the River Humber). The River Wharfe originates in 
the Yorkshire Dales National Park to the south of Bainbridge and flows south east through Ilkley, 
Otley, Wetherby and Tadcaster before entering the River Ouse near Cawood. There are also 
several tributaries that run through Ilkley into the River Wharfe including the Spicey Gill and 
Backstone Beck. 

The River Wharfe through Ilkley is a mainly natural channel, which has possibly had its route 
altered in the past (shown in Figure 3). The Environment Agency have stated that this original 
route is now a possible flow path of the flood water across the farm land. 

The geology around Ilkley is mainly superficial deposits of alluvium and till with a bedrock of 
sandstone. 

 
Figure 3: Possible historic watercourse route 

 
1.1.4 History of Flooding 

There have been several floods in Ilkley, notably severe floods in 1965, 1982, 1991 and 2002. 
The most recent floods were on Boxing Day 2015 where Ilkley was heavily affected and transport 
routes were disrupted in the area. It is assumed that properties did flood, however, there are no 
confirmed reports. 

The flooding outline from the Boxing Day 2015 flood event is shown in Figure 4. 
 

 
Figure 4 : Boxing Day 2015 Flood Map 
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1.1.5 Summary of modelling analysis 
The most recent modelling analysis is the 1D-2D ‘River Wharfe Modelling Study’ published by the 
Environment Agency in September 2014. This modelling does not, however, include Backstone 
Beck. 
 
Previously in 2009 Halcrow carried out the River Wharfe Flood Risk Mapping & NFCDD report on 
behalf of the Environment Agency. This report found the peak flows at various points on the River 
Wharfe with rainfall events with a 50%, 20%, 10%, 4%, 2%, 1.33%, 1%, 0.5%, 0.2% and 0.1% 
annual probability of exceedance. 
 
There is NaFRA modelling of the River Wharfe at Ilkley and the Flood Zone 2 and Flood Zone 3 
flood extents. There is also a Flood Map for Surface Water (FMSW) 1000yr event for the region. 
 

 
Figure 5: NaFRA Risk Bands at Ilkley 

 
1.1.6 Drivers, Constraints and Opportunities 

The following drivers constraints and opportunities have been identified within the study area.  

Table 1: Ilkley drivers, constraints and opportunities 
Political Drivers  Summary Description 

Catchment Flood Management Plan Ouse CFMP 2009 

Catchment Flood Management Policy 5 - areas of moderate to high flood risk where we 

can generally take further action to reduce flood 

risk 

Social Constraints   Summary Description 

Existing Public Space Ilkley Park, Ilkley Rugby Football Club, East Holmes 

Fields 

Existing Area of Multi-Functional Beneficial 

Open Space 

Ilkley Park, Ilkley Rugby Football Club, East Holmes 

Fields 
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Technological Drivers  Summary Description 

Improved Public Safety Through reduction of flood risk 

Legal Drivers  Summary Description 

Countryside Rights of Way Formal Notice 

Required 

Dales Way 

Environmental Constraints  Summary Description 

Ancient Woodland Owler Park, Stubham Wood and Hudson Wood 

within the study area. 

Scheduled Monument There are four listed buildings within the study 

area  

Listed Buildings/Structures There are four listed buildings within the study 

area  

WFD Body Good ecological status by 2027 

WFD Status Moderate 

 

1.2 Problem and objectives 

Problem 

There are currently no registered flood defences at Ilkley and the town has a long history of 
flooding, most recently in 2015. 

According to the mandate, residential properties on Denton Road, Gilstead Way and Middleton 
Avenue on the left bank of the River Wharfe are presently unprotected and at risk of flooding. 
There are estimated to be 58 properties at risk from a rainfall event with a 1 in 100 (1%) annual 
probability of exceedance, 51 of which are residential. 

There are also known flooding problems at the rugby ground and cricket pavilion. 

A flood alleviation scheme was proposed in 1992, including earth embankments, flood walls, 
footpath and road elevation and football field relocation, all in order to mitigate damages from a 
potential flood event. The earth embankment and walls had elevations between 1.4 and 2 metres 
high, however, the outline design didn’t go to construction. 

The current WFD status of the River Wharfe at Ilkley is moderate with a target of good ecological 
status by 2027 and good chemical status by 2015 (Humber river basin district RBMP 2009 Annex 
B: Water body status objectives). 

Objectives 

The objective is to identify a cost beneficial option to protect properties that are currently at risk 
from flooding at this location. 

The purpose of this report is to lay the groundwork and, where applicable, provide a business 
case for future appraisal. The report aims to achieve the following: 

• Confirm the need for a project; 
 

• Identify the issues and Political, Environmental, Societal, Technological, Legislative and 
Economic (PESTLE) drivers and opportunities related to the need; 
 

• Identify the options to address the need and problem; 
 

• Demonstrate that viable options exist based upon the available information; 
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• Provide sufficient information to allow the packaging and optimisation of packages of 
future appraisal, design and construction packages; 
 

• Provide sufficient information for the appraisal scope to be prepared; 
 

• Make an assessment on the deliverability of the project; 
 

• Provide a basis/starting point for discussion with communities and partner organisations 
for use in the development of potential schemes and negotiations regarding funding 
contributions. 

1.3 Benefits 

The benefits in this area associated with a reduction in flood risk would primarily be the reduction 
in economic damages to properties and maintaining open roads during high rainfall events.  This 
in turn would reduce disruption to local transport, businesses, schools and other infrastructure.   

The properties at risk according to NaFRA include 78 residential and 10 commercial buildings, 
distributed within the risk bands as shown below. 

Table 2: Ground floor and basement properties at risk from flooding - NaFRA 

Ground floor and Basement Properties at Risk from Flooding 

Residential Ground floor and Basement Properties at Risk 

  Low Risk Moderate Risk Significant Risk 
Very Significant 

Risk 

20% most deprived areas 0 0 0 0 

20%-40% most deprived areas 0 0 0 0 

60% least deprived areas 27 0 0 51 

Commercial Ground floor and Basement Properties at Risk 

  Low Risk Moderate Risk Significant Risk 
Very Significant 

Risk 

20% most deprived areas 0 0 0 0 

20%-40% most deprived areas 0 0 0 0 

60% least deprived areas 3 0 0 7 

Social benefits relate primarily to a reduction in stress, health effects (including risk to life) and 
loss of memorabilia for those at risk. 

The economic benefits for each option has been assessed against the Do Nothing scenario, in 
which the number of properties in each risk band have been increased by 20% to demonstrate 
the increased risk from climate change.  

An appraisal period of 100 years is assumed, over which the current standard of protection of 
existing assets is expected to decrease as a result of climate change. 

A description of the benefits assessment method is shown in Appendix B. 

1.4 Options 

A longlist of options has been compiled. The table on the following page shows the large range of 
longlist options considered and the reasoning for or against them being taken forward to the 
shortlist of options to be assessed. 
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Table 3: Long-list of options 

Category Long List Option Description Take Forward for 
assessment? 

Reasoning / Notes / Past Study Reference 

Do nothing Do nothing All operational and maintenance activities 
cease. 

Yes Required to support development of business 
case and benefit cost ratios. 

Do minimum Do minimum Continue with current operational and 
maintenance activities. 

 
Yes 

Represents the existing situation with 
maintenance of the river channel and river 
banks. 

Improve  
Maintenance 
and/or 
operation 

Do more Enhanced maintenance activities, 
including routine dredging, etc. Capital 
Maintenance. 

No As per our consultation with the Environment 
Agency, minimal maintenance is carried out 
along the river corridor of Ilkley. This is to 
allow some naturalisation of the channel with 
intervention only if necessary. 
There are three bridges, located within the 
study area. However, there are no reported 
blockage issues/damage problems. 
There is a weir - where the gauging station is 
located - at the Ilkley Old Bridge, however, 
there have been no reported issues with 
operation. 

Non-structural 
(by EA) 

Improved flood 
warning 

Enhanced flood warning to allow 
residents to prepare plus appropriate 
implementation of flood action plans 

No There are three gauging stations to the west 
of Ilkley on the river Wharfe at Addingham 
Town Beck, Addingham and Ilkley.  
These gauging stations are used to provide 
flood warnings and alerts for Ilkley therefore 
no additional gauging or warnings is thought 
to be needed. 



 

IMNE790567-CH2-FEV-ID0-AS-C-0001  Page 9 

Category Long List Option Description Take Forward for 
assessment? 

Reasoning / Notes / Past Study Reference 

Non-structural 
(by EA) 

Flood action plans Improved direction of reactionary flood 
defence measure (fire crews, temporary 
pumps, etc.) 

Yes, as a  
recommendation 

There are no known local flood groups in 
Ilkley, therefore, there is an opportunity to 
engage with the community and help people 
help themselves with flood awareness and 
action plans. 

Property level 
protection 

Property level 
protection 

Protection to individual properties (e.g. 
via air brick covers, door guards etc).  

Yes Property Level protection may be a viable 
option. 51 residential properties in Ilkley are 
estimated to be at a very significant risk of 
fluvial flooding. 
Four listed buildings around Ilkley flooded in 
the 2015 event, appropriate consents may be 
required for any proposed protection to them. 
Property Level Protection could also be useful 
as part of a wider scheme to offer protection 
to some properties not benefitting from the 
main option. 
This could particularly be the case for 
properties 1-9 Denton Road. 

Operational 
(by Others) 

Improve 
operation/design of 
assets not owned 
by the EA 

For example, appropriate control of flood 
flows from/through 3rd party sluices/weirs. 

No A site visit informed that there are no such 
defences present within the study area.  
There is a weir at Old Ilkley Bridge but it is 
owned by the Environment Agency. 

Land 
management 

Attenuate flows in 
rural area 
(farmland use) 

Changes to land management practices 
or in certain parts of the catchment 
specific areas managed in specific ways. 

Yes The catchment upstream of Ilkley Tennis Club 
is mainly rural, with the potential to attenuate 
flows in a flood event. A wider catchment 
flood risk management plan to attenuate flows 
upstream in the catchment could be effective 
at Ilkley.  
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Category Long List Option Description Take Forward for 
assessment? 

Reasoning / Notes / Past Study Reference 

Land 
management 

Attenuate flows in 
urban areas 
(SUDS) 

Use of SUDS drainage on new 
developments, make changes to urban 
areas to reduce speed of runoff. 

No There are no planned new developments in 
Ilkley.  

Urban drainage Improve urban 
drainage 

Improved surface water drainage system. No The updated flood map for surface water 100-
year and 1000-year shows that there are 
some residential properties, particularly in 
Bridge Lane, Middleton Road, Lakeside Close 
and Gilstead Way at risk. Bradford County 
Council are responsible for ensuring surface 
water drainage is sufficient. 

Structural Earth bunds Flood bund Yes In August 1992, Anthony Walker and Partners 
proposed a solution to construct new flood 
defences, a combination of embankments and 
walls, to provide protection against a rainfall 
event with a 1 in 100 (1%) annual probability 
of exceedance. However, this scheme wasn’t 
taken forward to construction. 
There are locations where flood bunds and 
defences could be newly constructed, but this 
would involve impinging on the football pitch 
due to the large footprint needed, making this 
a less desirable option compared to a wall 
which has a much narrower footprint, avoiding 
the football field and maximising the size of 
the flood plain. 
Previous engagement with Sport England 
have indicated very little appetite for any loss 
of amenity. 
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Category Long List Option Description Take Forward for 
assessment? 

Reasoning / Notes / Past Study Reference 

Structural Flood walls Flood walls Yes As detailed in section above, a design for the 
flood protection scheme was proposed in 
1992, but was not taken forward to 
construction. 
A low rise brick wall running along the south 
side of Denton Road from the junction with 
Middleton Avenue to the western edge of the 
football pitch is proposed. This would need to 
be in conjunction with raising of the road level 
at Denton Road/Middleton Avenue junction.    
Detailed modelling would be required for this 
option to be considered viable. 

Structural Demountable Temporary demountable defences Yes There are locations where demountable 
defences could be a viable solution. 
The temporary defence barriers on the west 
would begin from Nesfield Road and run 
along Denton Road and turning north up 
Middleton Avenue to join with the high-point. 
All residential properties could benefit, 
however Riverside hotel, located to the south 
of Dales Way, would still be at risk of flooding. 

Structural Conveyance Channel deepening or widening No Channel deepening and widening could 
potentially be carried out along much of the 
River Wharfe, particularly outside the urban 
reach of the river, however, due to the River 
Wharfe being a WFD body with moderate 
status, channel deepening is not considered a 
suitable solution. Due to river crossings 
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Category Long List Option Description Take Forward for 
assessment? 

Reasoning / Notes / Past Study Reference 

restricting the width of the channel, channel 
widening is not considered a suitable option. 

Structural Conveyance Channel straightening No This is not considered to be a suitable option 
for this watercourse. 

Structural Conveyance Supplementary bypass channel (s, 
tunnels or floodway 

No There is no suitable location for a bypass 
channel at Ilkley. 

Structural Conveyance River restoration and/or pinch point 
improvements (bridges, culverts and 
weirs) 

No This is not considered to be a suitable option 
for this watercourse as the River Wharfe is 
largely a natural channel. 

Flood storage 
area  

Online Use of active structures and re-profiling 
to store water online. 

Yes It is possible to create an online flood storage 
within the river corridor of Ilkley. This option 
could be used in conjunction with either a 
flood wall along Denton Road or raising the 
height of Denton Road 
It would be possible to reduce flood risk to the 
residential properties north of Denton Road, 
however, the properties located between 
Denton road and the river would remain at 
risk of flooding.  

Flood storage 
area 

Offline Gravity or pumping to offline storage area No This is not considered to be a suitable option 
for this watercourse. 

Floodplain 
storage 

Washlands-type 
scheme 

Enhance/increase natural floodplain 
attenuation with cascade of passive 
storage areas in existing floodplain 

No There are no suitable washlands for 
increased floodplain storage. 
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Shortlisted options description 
 
Do Nothing  
 
All operational and maintenance activities cease, this is the walkaway scenario. It is not a realistic 
option but is required as part of the appraisal by Defra Flood and Coastal Erosion Risk 
Management Appraisal Guidance. 
 
Do Minimum   
 
This option involves carrying out the basic level of maintenance required. Very little maintenance 
is currently carried out on the River Wharfe, however, there is an operational response. Due to 
this, this option is very similar to Do Nothing. 
 
Option 1   
 
Option 1 is to provide property level protection (PLP) for all residential properties that are 
currently at a very significant risk of flooding according to the NaFRA risk bands.  
 
This option will move 51 properties from the very significant to the significant risk band and the 
assessment has an appraisal period of 20 years. 
 
Option 2 
 
Construction of an earth embankment along the south side of Langbar Road, to the south of all 
Denton Road properties through the football playing fields and to the south of Ilkley rugby ground. 
The embankment will have a maximum side slope of 1 in 4 and a total length of 1410m. Surface 
water outfall from Denton Road and Middleton Avenue will be designed into the embankment 
using penstocks and non-return valves. This option will protect all properties to the north of the 
embankment against a rainfall event with a 1 in 100 (1%) +CC annual probability of exceedance. 
 
Property level protection has been included for the 8 properties at a very significant risk of 
flooding that are located to the south of the river and won’t be protected by the earth 
embankment. Therefore, the cost of PLP for 8 properties has been included in Year 0, with only 
the cost of the main scheme to be used as an intervention cost in Year 50.  As the appraisal 
period for property level protection is 20 years, these benefits have been calculated in a separate 
benefits spreadsheet from the main option benefits. This can be seen in Appendix B. The risk of 
flooding to these properties may also be increased further due to the loss of flood plain to the 
north of the river, at appraisal stage this will need to be fully assessed and compensatory works 
will need to be costed. 
 

 
Figure 6: Location of new embankment 
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Option 3  
  
Construction of a brick-clad reinforced concrete flood wall along the south side of Denton Road. 
This wall will be 1.1m high and will run for a total of 1110m. Road raising will also be carried out 
at the junction between Denton Road and Middleton Avenue.  Surface water outfall from Denton 
Road and Middleton Avenue will be designed into the embankment using penstocks and non-
return valves. 
 
This will protect all properties to the north of Denton Road against a rainfall event with a 1 in 100 
(1%) +CC annual probability of exceedance. 
 
Property level protection has been included for the 8 properties at a very significant risk of 
flooding that are located to the south of the river and won’t be protected by the flood wall. 
Therefore, the cost of PLP for 8 properties has been included in Year 0, with only the cost of the 
main scheme to be used as an intervention cost in Year 50. As the appraisal period for property 
level protection is 20 years, these benefits have been calculated in a separate benefits 
spreadsheet from the main option benefits. This can be seen in Appendix B. The risk of flooding 
to these properties may also be increased further due to the loss of flood plain to the north of the 
river, at appraisal stage this will need to be fully assessed and compensatory works will need to 
be costed. 
 

 
Figure 7: Location of the new flood wall and raised road. 

 
Option 4  
 
Deployment of 900m of demountable defences along Langbar Road, Denton Road and Middleton 
Avenue to protect properties to the north of Denton Road. The demountable defences will protect 
properties again a rainfall event with up to a 1 in 30 (3.33%) annual probability of exceedance. 
 
The effectiveness of demountable defences depends on suitable prior warning being given and a 
comprehensive Temporary Defence Deployment Plan (TDDP) being produced that can be 
followed and enacted in the event of a flood. Suitable forecasting capabilities will need to be in 
place for this option to be effective. 
 
The Environment Agency’s “Cost estimation for temporary and demountable defences – 
summary of evidence, March 2015” suggests an appraisal period of 100 years. The cost of 
deployment prior to the flood, inspection for 24 hours and demobilisation after the flood for 250m 
of barrier is also suggested to be £6,500. Therefore, for 900m of a barrier a cost of £23,400 has 
been used and deployment is assumed to be carried out once every 10 years for the first 20 
years, then at increasingly more frequent events as the effects of climate change are realised. 
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Finally, there is an annual maintenance and storage cost for the barriers, that has been taken as 
£4,500/year from the aforementioned report. 
 
Property level protection has been included for the 8 properties at a very significant risk of 
flooding that are located to the south of the river and won’t be protected by the demountable 
defences. Therefore, the cost of PLP for 8 properties has been included in Year 0, with only the 
cost of the main scheme to be used as an intervention cost in Year 50. As the appraisal period for 
property level protection is 20 years, these benefits have been calculated in a separate benefits 
spreadsheet from the main option benefits. This can be seen in Appendix B. The risk of flooding 
to these properties may also be increased further due to the loss of flood plain to the north of the 
river, at appraisal stage this will need to be fully assessed and compensatory works will need to 
be costed. 
 

 
Figure 8: Route of demountable defence 

 
Option 5  
 
A flood storage area (FSA) constructed within farm/agricultural land upstream of Ilkley. This FSA 
could be landscaped to be 65,000m2 in area with a depth of 1m throughout, created by 
excavation and bunds. The inlet to the FSA would be an inspill that will be set to overtop when 
the river reaches the equivalent level of a rainfall event with a 1 in 10 (10%) annual probability of 
exceedance, below the current threshold of flooding. The outlet is just upstream of the Ilkley 
Lawn Tennis and Squash Club and will allow water in the FSA to empty once the peak flows have 
passed. Hydraulic modelling will be required to check this option at appraisal stage. 
 
The option will protect properties to the north of the river against a rainfall event with up to a 1 in 
75 (1.33%) annual probability of exceedance and properties to the south of the river against a 
rainfall event with a 1 in 20 (5%) annual probability of exceedance. 
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Figure 9: Location of flood storage area 

 
1.1.7 Costs of options 
The costs for the five options were calculated using the Environment Agency’s Project Cost Tool 
and Long Term Costing Workbook. The maintenance and operation costs relate to: 
 

• Maintenance of the assets to Target Condition 3, carried out mechanically. 
• Annual incident response cost 

 
It is assumed that a major replacement of assets will be required at some point during the 
appraisal period and after the initial construction phase. A detailed breakdown of costs is included 
in Appendix A. 
 
Table 4: Project costs (£) 

Item Do 
Minimum Option 1 Option 2 Option 3 Option 4 Option 5 

Costs to PAR   

Consultant Fees 
(Appraisal) 

 19,997.71 55,490.71 153,535.39 52,710.34 162,283.74 

Costs post PAR  
Construction 

Base Cost 
 357,102 1,124,461 3,125,373 941,256 3,311,913 

Environment 
Agency staff 

 54,636.61 84,430.05 226,494.80 144,012.17 235,145.82 

Consultant fees 
(design)  68,920.69 155,051.17 425,174.29 181,662.41 447,108.26 

Consultant fees 
(construction) 

 17,855.10 63,702.17 177,754.15 47,062.80 188,779.04 

Site investigation 
& survey 

 4,642.33 41,329.13 117,373.78 13,121.57 125,852.70 

Land Purchase  228.55 5,378.08 15,382.64 4,462.05 16,559.57 
Risk 

Contingency 
(44%)  

 230,288.51 673,130.60 1,866,074.33 609,086.43 1,974,562.53 

TOTAL   753,671.48 2,202,972.86 6,107,152.36 1,993,373.76 6,462,204.65 
Annual 

Maintenance Cost 
(target condition 3) 

1407.36 1407.36 2370.27 2713.83 5,907.36 3542.26 

Annual 
Operational Cost 650 650 650 650 650 650 

Appraisal Period 100 20 100 100 100 100 

Intervention  
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Item Do 
Minimum Option 1 Option 2 Option 3 Option 4 Option 5 

Costs 
Year 10     24,000  
Year 20     24,000  
Year 28     24,000  
Year 36     24,000  
Year 44     24,000  
Year 50   2,084,749.88 5,988,929.38 1,899,150.78 6,462,204.65 
Year 52     24,000  
Year 59     24,000  
Year 66     24,000  
Year 73     24,000  
Year 79     24,000  
Year 85     24,000  
Year 90     24,000  
Year 95     24,000  

Present Value 
Cost  

61,335 784,969 2,704,258 7,388,829 2,634,742 7,861,939 

 
 

1.5 Initial environmental assessment 

The River Wharfe at Ilkley is primarily a natural channel. The works being proposed do not 
significantly affect the environmental status of the watercourse or the surrounding environment. 
The main impacts of each option are described in the table below. 
 
Table 5: Key environmental impacts, mitigation and opportunities 

Key positive impacts Key negative impacts Mitigation/ enhancement 
opportunity 

Option 1 – Property Level Protection  
No major impacts upon the 
existing environment 

Minor works on buildings may 
produce noise, vibration and 
dust.  

It is recommended that adverse 
impacts should be minimised as 
much as possible through the 
adoption of ‘best practicable 
means’ as defined in the Control of 
Pollution Act 1974 to minimise 
noise and vibration resulting from 
construction operations and shall 
have regard to British Standard BS 
5228 1997 code of Practice for 
Noise Control on Construction and 
Open Sites. 
 

 Short-term, temporary dust 
impacts possible during 
construction. 

Adverse impacts should be 
minimised through the adoption of 
‘best practice measures’. 
 

Option 2 – Construction of flood bund  
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Key positive impacts Key negative impacts Mitigation/ enhancement 
opportunity 

Improved standard of 
protection from flooding 

Noise, Vibration and dust. It is recommended that adverse 
impacts should be minimised as 
much as possible through the 
adoption of ‘best practicable 
means’ as defined in the Control of 
Pollution Act 1974 to minimise 
noise and vibration resulting from 
construction operations and shall 
have regard to British Standard BS 
5228 1997 code of Practice for 
Noise Control on Construction and 
Open Sites. 
 

Potential opportunities for 
betterment and WFD 
improvements. 

The construction of any hard 
structures within the town of 
Ilkley have the potential to have 
a visual impact. 

Defence raising will require a 
suitable visual assessment, 
however this is dependent upon the 
option selected. 
Innovative solutions may be an 
available that maintain visual 
standards permanently or which 
only obstruct vision during a flood 
event.  

 Trees may be affected by raising 
of embankments/construction of 
flood walls. 

It is recommended to pursue an 
Extended Phase 1 habitat survey 
during which trees and vegetation 
will be identified and recorded. 

 Potential for temporary footpath 
diversion during construction and 
permanent diversion following 
construction. 

Any restrictions need to be fully 
explored and mitigated for during 
the detailed design stage of the 
project. 
Opportunities should be explored to 
enhance those footpaths which 
may be permanently moved 
following the works. 

 Loss of floodplain Further modelling would be 
required in order to assess the 
impact of removal of flood plain due 
to the construction of flood 
bunds/walls on communities further 
downstream. Compensatory flood 
plain storage may be required, 
adding to the costs of the scheme. 
It must be ensured that the 
compensatory storage is 
hydraulically linked to the flood 
plain lost, otherwise the benefits 
from it may not be fully realised. 
 

 Loss of amenity of the football 
field. 

Embankment to be designed either 
to minimise the side slope (allowing 
use of the football field) or to 
maximise the side slope (to reduce 
the intrusion onto the football field). 
 

Option 3 – Construction of flood wall  
As per option 2 above. As per option 2 above. As per option 2 above. 
Option 4 – Demountable Defences  
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Key positive impacts Key negative impacts Mitigation/ enhancement 
opportunity 

As per option 1 above. Flood water level will be 
increased as the flood plain is 
reduced. 

Adverse impacts should be 
minimised through the adoption of 
‘best practice measures’. Further 
modelling should be undertaken to 
assess the impact of removal of the 
flood plain and the affect this will 
have further downstream. 
Compensatory storage may be 
required. 
 

Option 5 – Construction of a flood storage area  
Improved standard of 
protection from flooding 

Noise, Vibration and dust. It is recommended that adverse 
impacts should be minimised as 
much as possible through the 
adoption of ‘best practicable 
means’ as defined in the Control of 
Pollution Act 1974 to minimise 
noise and vibration resulting from 
construction operations and shall 
have regard to British Standard BS 
5228 1997 code of Practice for 
Noise Control on Construction and 
Open Sites. 
 

Potential opportunities for 
betterment and WFD 
improvements. 

Trees may be affected by raising 
of embankments/construction of 
flood walls. 

It is recommended to pursue an 
Extended Phase 1 habitat survey 
during which trees and vegetation 
will be identified and recorded. 
 

 Potential for temporary footpath 
diversion during construction and 
permanent diversion following 
construction. 

Any restrictions need to be fully 
explored and mitigated for during 
the detailed design stage of the 
project. 
Opportunities should be explored to 
enhance those footpaths which 
may be permanently moved 
following the works. 
 

 

1.6 Consultation 

The options in this Initial Assessment were developed in consultation with the Environment 
Agency. No public consultations were held at this stage, as the purpose of this work is a broad 
brush assessment of potential options. Stakeholder engagement will take place at subsequent 
stages of the project. 
 

1.7 Economic summary and preliminary preferred opti on 

The table below summarises the economic assessment carried out for all options. The 
calculations for PV benefits are shown in Appendix C. 
 
Table 6: Benefit-cost assessment 

 
PV costs  

(£k) 

PV 
benefits 

(£k) 

Av. 
BCR 

Incr’ 
BCR 

Option for iBCR  
calc Comments 

Do Nothing    - - - Baseline option for comparison 
purposes only. 

Do 61 2,166 35.51 N/A N/A 
Do Minimum gives the best 

BCR. However, the Do 
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Minimum Minimum option leaves an 
unacceptably high level of flood 

risk and does not meet the 
project objectives, so is not 

taken forward for further 
assessment. 

Option 1 785 4,935 6.29 N/A N/A 
PLP for all properties at a Very 

Significant risk of flooding. 

Option 2 2,704 12,973 4.80 N/A N/A 

Construction of an earth 
embankment to the north of the 
River Wharfe and PLP for the 8 

properties to the south of the 
river. 

Option 3 7,389 11,450 1.55 N/A N/A 

Construction of a flood wall to 
the north of the River Wharfe 

and PLP for the 8 properties to 
the south of the river 

Option 4 2,635 10,448 3.97 N/A N/A 

Demountable defences to the 
north of the River Wharfe and 
PLP for the 8 properties to the 

south of the river 

Option 5 7,862 6,943 0.88 N/A N/A 
Construction of an offline flood 

storage area upstream of Ilkley. 
 
Do Minimum has by far the best BCR of 35.51. However, this option does not meet the project 
objectives of reducing the flood risk to any properties, therefore, it has not been taken forward for 
further assessment. 
 
Of the Do Something options, Option 1 has the greatest BCR with 6.29. This is due to the fact 
that the cost is significantly lower than that for Options 2, 3, 4 and 5. 
 
Option 2, 3 and4 all have good BCRs with 4.80, 1.55 and 3.97 respectively, therefore, they will all 
be taken forward for further assessment. 
 
Option 5 has the lowest BCR of 0.88, however, this will still be taken forward through the 
assessment. 
 
Table 7: Benefit-cost ratios and outcome measures 
Contributions to outcome 
measures  Option 1 Option 2 Option 3  Option 4 Option 5 

OM1 – Economic Benefit:       

    Benefit period used for 
Partnership Funding calcs 

20 100 100 100 100 

    PV Benefits 4,935,162 12,973,371 11,450,138 10,448,284 6,943,488 
    PV Costs 784,969 2,704,258 7,388,829 2,634,742 7,861,939 
    Benefit/Cost ratio 6.29 4.80 1.55 3.97 0.88 
OM2 – No. of households 
moved out of any flood 
probability category to a lower 
category 

51 51 51 51 43 

OM2b – No. of households for 
which the probability of flooding 
or coastal erosion is reduced 
from the very significant or 
significant category to the 
moderate or low category 

0 43 43 0 0 

OM2c – No. of households in 
the 20% most deprived areas 
moved from the very significant 
or significant flood probability 
category to the moderate or low 

0 0 0 0 0 
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category  

OM4a – Hectares of water 
dependent habitat created or 
improved to help meet the 
objectives of the Water 
Framework Directive 

0 0 0 0 0 

OM4b – Hectares of intertidal 
habitat created to help meet the 
objectives of the Water 
Framework Directive for areas 
protected under the EU 
Habitats/Birds Directive  

0 0 0 0 0 

OM4c – Kilometres of rivers 
protected under the EU 
Habitats/Birds Directive 
improved to help meet the 
objectives of the Water 
Framework Directive 

0 0 0 0 0 

Partnership Funding (PF) Score  46% 16% 5% 13% 3% 

Contributions required for a PF 
score of 100% (£) 

426,735 2,268,115 6,990,767 2,299,287 7,625,751 

Contributions required for a PF 
score of 120% (£) 

583,727 2,808,966 8,468,533 2,826,235 9,198,138 

 
 
 
 

Funding and contributions 

A funding analysis tool (see Appendix D) was used to identify potential direct and indirect 
beneficiaries of the scheme. Based on these beneficiaries, potential funding sources were 
identified. They include: 

• Community Infrastructure Levy (CIL) 
• Levy on residential properties (e.g. Council Tax) 
• Local businesses 

 
It is recommended that this funding analysis tool is updated at later stages of this scheme, when 
a more detailed and precise analysis of beneficiaries can be carried out. 
 
 
1.1.8 Key delivery risks (economic, social and envi ronmental) 
Table 8: Risks and mitigation 

Risk Key Mitigation 

Assumptions used to calculate damages could result in 
large inaccuracies in PV benefits. The benefit area has 
been approximated using best available data and 
engineering judgement, but could result in large 
inaccuracies. 

Sensitivity testing has been undertaken which 
shows that the leading option remains cost 
beneficial. Breach and or blockage modelling 
should be carried out before progressing this 
scheme further, to improve estimation of the 
benefit areas. 
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Risk Key Mitigation 

The proposed works may cause disruptions to local 
residents and surrounding businesses. There is likely 
to be some temporary increased noise during the 
works. 

Consultation and strict working hours will be 
required. It is recommended that adverse 
impacts should be minimised as much as 
possible through the adoption of ‘best practicable 
means’ as defined in the Control of Pollution Act 
1974 to minimise noise and vibration resulting 
from construction operations and shall have 
regard to British Standard BS 5228 1997 code of 
Practice for Noise Control on Construction and 
Open Sites. 

Environmental risks Refer to environmental assessment in Appendix 
A 

 
 

1.8 Project Scoring 

The data used in this assessment has been subjected to a RAG assessment. The results are 
shown below: 
 

• A – Problem Definition: The fluvial and surface water flooding mechanisms are well 
understood but no hydraulic modelling data has been used in the assessment – AMBER  

• B – Economic Case: The benefits assessment has been based on moving properties from 
flood risk bands and weighted average annual damages – RED 

• C – Funding: The options are likely to require external funding. Alternative funding 
sources have been identified – AMBER  

• D – Engineering Case: Options are based on new engineering solutions and have been 
taken to an outline design level – GREEN 

• E – Permissions & Consents: Solutions are likely to require permissions or consents of 
council/private owners – GREEN 

• F – Environmental Sensitivities: Initial environmental assessments has been completed 
based on outline options – AMBER  

• G – Opportunities: Some potential opportunities for partnership working but minimal 
environment opportunities – AMBER  

 
Model. 

A 
Econ. 

B 
Funding 

C 
Eng. 

D 
Permission 

E 
Env. 

F RAG Opps. 
G 

2 3 2 1 1 2 132 
 

2 

 
The RAG score is used to give an indication of the viability of the project at this stage. 
 

1.9 Further work requirements 

It is recommended that to gain a clearer understanding of the flood risk, new modelling of the 
River Wharfe should be undertaken. 
 
The table below gives an estimate of the complexity and duration of the project at each of the 
following Gateways. 
 
Table 9: Programme Key dates 

Gateway Activity Complexity Duration (months) Estimated 
Date 

G0 Initial Assessment Complete - - 
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Gateway Activity Complexity Duration (months) Estimated 
Date 

 
River Wharfe hydraulic 

modelling 
Medium 4 

01/01/2017 – 

01/05/2017 

 

Update Initial 

Assessment and 

forward programme 

dates 

Simple 1 01/06/2017 

G1 Project start date   01/06/2017 

 Strategic Outline Case Simple 3 01/09/2017 

 Appraisal Simple 6 01/03/2018 

 Outline Business Case Medium 4 01/07/2018 

G2 Detailed Design Medium 12 01/07/2019 

G3 
Financial Business Case 

/Contract Award 
Simple 4 01/11/2019 

G4 
Construction 

Completion 
Medium 12 01/11/2020 

G5 Handover Simple 12 01/11/2021 

 

1.10 Conclusions and Recommendation 

In this Initial Assessment, the following options have been considered: 
 

• Do Minimum : Continue with the current basic maintenance carried out on the 
River Wharfe at Ilkley 

• Option 1 : Provide property level protection (PLP) for the 51 residential properties 
that are currently at a very significant risk of flooding. 

• Option 2 : Construct an earth embankment through the playing fields to the south 
of Denton Road to protect effected properties against a rainfall event with a 1 in 
100 (1%) annual probability of exceedance and provide PLP for the properties to 
the south of the river. 

• Option 3 : Construct a flood wall along the south of Denton Road to protect 
effected properties against a rainfall event with a 1 in 100 (1%) annual probability 
of exceedance and provide PLP for the properties to the south of the river. 

• Option 4 :  Deployment of 900m of demountable defences along Langbar Road, 
Denton Road and Middleton Avenue to protect properties to the north of Denton 
Road and provide PLP for the properties to the south of the river. 

• Option 5 : Construction of a 65,000m2 flood storage area within farm/agricultural 
land upstream of Ilkley. This will protect the properties to the north of the river 
against a rainfall event with a 1 in 100 (1%) annual probability of exceedance and 
the properties to the south of the river against a rainfall event with a 1 in 75 
(1.33%) annual probability of exceedance. 

 
Options not assessed directly but recommended include investigation of maintenance regime for 
ordinary watercourses and engagement with the local community. Please note that options 
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considered only address the fluvial flood risk and risk from sources including but not limited to 
surface water, sewer and canal must be considered in the further development of the options. 
 
The economic benefits for each option has been assessed against the Do Nothing scenario, in 
which the number of properties in each risk band have been increased by 20% to demonstrate 
the increased risk from climate change. It is noted that the estimation of scheme benefits for this 
Initial Assessment has been based on property counts from NAFRA and the Weighted Annual 
Average Data from the Middlesex Multi-Coloured Manual, which is known to be inaccurate. 
 
Option Scoring Discussion 
 
The Do Minimum option gives the best BCR (35.51), however, the option leaves an unacceptably 
high level of flood risk and does not meet the project objectives. Therefore, this option has been 
discounted. 
 
Of the Do Something options, Option 1 gives the best BCR (6.29) and best partnership funding 
score, 46%. These figures are the result of the low PV cost of PLP for the 51 properties at a very 
significant risk of flooding (£784,969). The PV benefits provided (£4,935,162) are in fact the 
lowest amount of benefits provided by any of the Do Something options, and there are no OM2b 
or OM2c benefits.  
 
Option 2 gives the greatest amount of PV benefits (£12,973,371) and with a PV cost of 
£2,704,258 there is also a good BCR of 4.80. Option 2 also provides the same OM2 benefits as 
Option 1, plus OM2b benefits of 43. Option 3 also provides the same OM2 and OM2b benefits as 
Option 2, however, it only have BCRs of 1.55 as a result of lower PV benefits of £11,450,138 and 
higher PV costs of £7,388,829. 
 
Option 4 provides the same OM2 benefits as all previous options and, like Option 1, does not 
provide any OM2b or OM2c benefits. With PV benefits of £10,448,284 and PV costs of 
£2,634,742, Option 4 provides a BCR of 3.97. However, there are uncertainties surrounding the 
costs associated with Option 4, as demountable defences have been purchased by the 
Environment Agency as part of a nationwide scheme to support communities remaining at risk 
from flooding. Ilkley meets the criteria to be included in this scheme, and therefore costs could be 
reduced if it is packaged together with other qualifying communities. 
 
Option 5 provides the lowest BCR (0.88) and PF Score of all of the options due to a PV Cost of 
£7,861,939 and PV Benefits of £6,943,488. There are also uncertainties surrounding the volume 
of the storage area and whether this will be suitable enough to provide the described benefits. As 
the BCR is below 1, this option therefore not likely to be taken forward to appraisal, however, if 
another area is found further upstream that could increase the overall volume of storage the 
option could potentially be looked into further. 
 
There are only 10 commercial properties at risk from flooding in Ilkley, 3 of which are at a low risk 
and 7 of which are at a very significant risk. Due to this the potential for Partnership Funding from 
local businesses is low. Potential funding partners at this stage are:  

• Community Infrastructure Levy (CIL) 
• Levy on residential properties (e.g. Council Tax) 
• Yorkshire Water 
• Local businesses 

 
When considering any of the above options, effects on Yorkshire Water assets such as combined 
sewer overflows (CSOs) and the ability to discharge from surface water outfalls must be 
assessed. There are also several Yorkshire Water assets downstream including Ilkley’s 
Wastewater Treatment Works.  
 
It is highly recommended that detailed hydraulic modelling should be carried out in order to give a 
clear understanding of the Do Nothing and Do Minimum scenarios and including 1D and 2D 
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modelling of the River Wharfe. These should be carried out before a decision is taken on whether 
to progress to development of an OBC and develop further the options assessed here. 
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Appendices 


